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KARMA Motif  
Installation and First Launch 
Revision 13-Feb-2017 © by Stephen Kay 

Overview 

This document will take you through the steps of installing the software, getting it authorized, and 
launching it for the first time. Furthermore, it contains several sections related to the supported 
Yamaha devices (XS, XF, MOX, MOXF, Rack-XS, S70/S90 XS) explaining how to load the KARMA 
Yamaha Data that we provide so that the program works correctly. Therefore, don’t be worried by the 
length – much of the document does not apply to your particular device, since there are six different 
Yamaha models supported by this document. 

Prerequisites – MIDI Drivers 

It is assumed that you already have the latest (and correct) Yamaha USB Driver (or FireWire Driver if 
using that option). If not, proceed to download.yamaha.com and locate the correct driver for your 
keyboard. The files are named like: 
XF, XS, Rack-XS, S70/S90 XS: USB-MIDI Driver Vx.x.x (if using USB) 

Yamaha Steinberg FW Driver Vx.x.x (if using FireWire) 
MOX, MOXF:   Yamaha Steinberg USB Driver Vx.x.x 

XF and XS Users: If you are using FW, it’s important to perform the modification to the Motif’s MIDI 
settings discussed later in this document after loading the Motif XS/XF data. 
MOXF Users: You need to have firmware version 1.03 or later in your MOXF to load our data file. To 
view the firmware version of your MOXF, press the UTILITY button, then press the JOB button. Visit 
download.yamaha.com for the latest firmware updater. 

Installation/Authorization of the software on the Mac 

1. Download: Mount the disk image installer file that you downloaded, double-click the installer icon. 
CD version: Mount the CD on your computer and double-click the installer icon. As with any 
software, you may wish to disable virus detection software during installation to be safe. 

2. Follow the instructions. When the installation is complete, the KARMA Motif folder should open. 
3. Double-click the KARMA Motif application icon. You will be presented with the authorization 

dialog. You must authorize the application at karma-lab.com/register/kmo. Consult the “How To 
Authorize” document in the installation folder if further info is required - it is also available online 
at How To Authorize. Your “Customer Registration Number” was sent to you in the download 
email or was included in the CD package if you ordered it on CD. 

4. You can leave the dialog open, or close it while waiting to receive the Response Code via email. In 
the meantime, proceed to the next section to prepare your keyboard or rack to work properly with 
the software. 

5. The disk image installer file can be dismounted/ejected at this time, as it is no longer necessary. If 
using the downloaded installer, you may wish to keep this in case reinstallation is necessary, 
although you can contact us for a new download at any time. 

Installation/Authorization of the software on Windows 

32-bit operating systems: 
1. Download: Save the file to your hard drive, which has a name like “kmo_330_full_xx32.exe”, then 

double-click it to launch the installer. CD version: Locate the folder containing the 32-bit installer 
for your operating system, which contains the same file, then double-click it to launch the installer. 
Consult the instructions file on the root of the CD for more information if necessary. 

www.karma-lab.com 

http://karma-lab.com/karmasoft/kmo/files/HowToAuthorize-KMo.pdf
http://download.yamaha.com
http://download.yamaha.com
http://karma-lab.com/register/kmo
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2. If you receive the message "The publisher could not be verified" or "An unidentified program 
wants to access your computer" etc., click "Run" or “Allow” and follow the instructions. As with any 
software, you may wish to disable virus detection software during installation to be safe. 

3. Follow the instructions. When the installation is complete, the KARMA Motif shortcut icon will be 
installed on your desktop. There will also be Karma-Lab entries in your Start Menu. Reboot the 
computer if instructed to do so.  

4. Continue with the instructions for “both” below. 
64-bit operating systems: 
5. Download: Save the file to your hard drive, which has a name like “kmo_320_full_xx64.zip”, and 

un-zip it (decompress). You will have a folder containing two installers, both of which must be run, 
and an instructions file. Please consult the instructions for details on how to run the two installers. 
CD version: Locate the folder containing the 64-bit installers for your operating system, which 
contains the same two installers, both of which must be run, and an instructions file. Please 
consult the instructions for details on how to run the two installers.  

6. Follow the instructions. When the installation is complete, the KARMA Motif shortcut icon will be 
installed on your desktop. There will also be KARMA Motif entries in your Start Menu. Reboot the 
computer if instructed to do so.  

7. Continue with the instructions for “both” below. 
Both (continue): 
8. Double-click the KARMA Motif shortcut icon on the desktop. You will be presented with the 

authorization dialog. You must authorize the application at karma-lab.com/register/kmo. Consult 
the “How To Authorize” document in the installation folder if further info is required - it is also 
available online at How To Authorize. Your “Customer Registration Number” was sent to you in the 
download email or was included in the CD package if you ordered it on CD. 

9. You can leave the dialog open, or close it while waiting to receive the Response Code via email. In 
the meantime, proceed to the next section to prepare your Motif to work properly with the 
software. 

10. If using the CD version, the CD can be ejected at this time, as it is no longer necessary. If using the 
downloaded installer, you may wish to keep this in case reinstallation is necessary, although you 
can contact us for a new download at any time. 

Loading the KARMA Yamaha Data 

Before you use the software, you must load the KARMA Yamaha Data that we provide into your 
Yamaha device, or the KARMA Performances will not play correctly. Click the links below to locate the 
section pertaining to your Yamaha device. Remember to return to this page to finish the rest of the 
“First Launch” procedure! 
Motif Rack-XS   MOX and MOXF 
Motif XS and Motif XF  S70/S90 XS 

Completion of the authorization 

Once you receive the Response Code back via email, copy it and enter it in the authorization dialog 
(launch the app again if you closed the dialog previously), and proceed. Once the code is accepted, 
press the “Finish” button and the application should begin the initial launch. Your software is now 
authorized on that computer, and will subsequently launch without any further requirements. 

  

http://karma-lab.com/karmasoft/kmo/files/HowToAuthorize-KMo.pdf
http://karma-lab.com/register/kmo
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Selecting the Device Type and MIDI Connection Type 

Partway through the initial launch, you will see the following 
dialog asking you to choose the Device Type (XS, XF, MOX, MOXF, 
Rack-XS or S70/S90 XS), and the type of MIDI Connection (USB or 
FireWire). Please select the correct device type and USB or FireWire 
and press OK – if you happen to have more than one of the 
supported Yamaha devices connected, choose the one that you 
want to try the software with. 
(There is also a MIDI connection option “MIDI Interface”, but it is 
not recommended to use this older type of connection, as some 
functionality is not available, such as the use of the Remote Mode 
to control KARMA.) 

Auto-configuration/First Launch Dialog 

The software attempts to auto-configure itself based on the names of the Yamaha Drivers and 
establish communication with the your Yamaha device. Assuming that your Yamaha is on and 
connected via USB (or FireWire/mLAN), you should see the following dialogs on top of the main 
application window (the port designations may be different): 

If you do not see “Auto-configuration complete” in the Communication Status Window, please follow 
the instructions provided in the dialog. Otherwise, you can close the Communication Status Window. 
The “First Launch” dialog advises you to consult this tutorial and the next tutorial “Getting Started”, 
and provides an easy way to locate the Tutorials folder on your computer. 
Please continue with the “Getting Started” tutorial to learn your way around the application, and learn 
some general information about Performances, Scenes, and much more! 

Additional Rack-XS Setup 

If you are using the Motif Rack-XS, there are a few additional steps you must take to allow a controller 
keyboard to operate the KARMA Motif software while playing the sounds on the Rack-XS. 
From within the KARMA Motif 
application, choose “KARMA Help” 
from the Help Menu (which will 
open the Help File/Manual to the 
Table Of Contents). Scroll to the 
bottom of the Table Of Contents, 
and in the “Appendices – KARMA 
Motif” section, click on the 
“Additional Rack-XS Setup” link to 
go to that chapter where the 
additional steps are explained.   
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Motif XS/XF – loading the KARMA Yamaha Data 
 

 
 Loading the Motif XS/XF Data - Overview 

Before you use the software, you must load the KARMA data that we provide into your Motif, or the 
KARMA Performances will not play correctly. This will replace the data in your keyboard with our data. 
Therefore, it is strongly recommended that you backup the state of your machine to an “all” file on 
your USB stick prior to loading the KARMA data, so that you can restore your original setup later. 
This is the easiest way to try out the KARMA Motif software without having to wade through pages 
and pages of settings, and trying to load only certain banks of sounds. Later you can think about 
merging the KARMA data into your own file if that is something you wish to do. We provide 
instructions on this for advanced users in another document. However, for your first experience with 
KARMA Motif, the best and recommended method is to load our data file. 
If you have never done this before or are worried about this procedure, please read the rest of this 
section. Otherwise, proceed to the next section “Loading the Motif XS/XF Data - Procedure.” 
If you are new to the idea of replacing the contents of your Motif with something else in order to use a 
specific program, think of it this way: the KARMA data is a "file for a particular purpose". The contents 
of the keyboard can be changed. You can load one file for one purpose, and another file for another 
purpose. This is common for more advanced users - it takes just a few moments to load a completely 
new file that changes all of the contents of your Motif from one setup to another setup. You can have 
one set of data you use with KARMA, one set of data you use with a DAW, one set of data you use for 
live performance, etc. 
Why is this necessary? The KARMA software uses the 64 Songs in Song Mode to produce the music. 
The Songs themselves have various Voices loaded into each track to produce the correct sounds. If we 
were to only load the Songs, then if you had different Voices in your User3 Bank (for example), they 
would not sound correct because the Voices that we created the Songs to use might not be in the 
correct locations. That is why we need to get the Motif set to a state where everything matches the 
data that we have produced. 
Secondly, various system settings need to be set a certain way for the whole thing to work correctly 
such as MIDI settings, Remote Mode settings, etc. We have configured the software to work with 
certain settings in the Motif. If a user has changed those to something else, then it won't work 
correctly. That's why we replace everything with the correct settings for KARMA. All you have to do to 
reset your keyboard for other purposes is to load your own data file. 
Unfortunately, Yamaha does not provide a way to easily load just certain types of data, and certain 
system settings, without replacing the whole thing. We chose the easiest way to get the Motif 
configured to match KARMA, by loading an "all" file with system settings. 
If you later wish to create your own version of the KARMA Yamaha Data that we supply, so that it also 
includes your own customized Voices, Performances, Masters etc. that you normally have loaded, you 
can follow the steps in a different tutorial named “Creating your own KARMA Yamaha Data File.” 
However, we don’t recommend doing that now until you’ve first experienced using the software with 
the correct data and settings. 
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Loading the Motif XS/XF Data - Procedure 

1. First, we highly recommend backing up the current state of your Motif to an “all” data file on your 
USB stick. Then you can reload your own "all" file at any time, thereby returning your Motif to the 
exact state it was in prior to loading our file. If you need help with this, please consult your owner’s 
manual. For the XS, it’s in the “Reference > File Management > Saving a file” section, and for the 
XF, it’s in the “Saving/Loading Data in the File mode” section. In addition, you can consult the 
“Yamaha Beginner’s Resources” section at karma-lab.com/kmo/docs. 

2. Locate the “Yamaha Data” folder in the application’s folder on your computer. On Windows, you 
will also find a shortcut to this folder in the Start Menu (and on the desktop). You will see a 
number of folders inside that contain data files for the different Yamaha Models that KARMA Motif 
supports. Open the folder for your Motif (XS or XF) – you will see one of the following “all” files: 

Motif XS: KMO Factory Data 1.X0A 
Motif XF: KMO Factory Data 1.X3A 

The default folders containing these files on your computer are: 
Mac: 
~/Applications/KARMA Motif/Yamaha Data/YourModel/ 
Windows 8, 7, Vista: 
C:\Users\Your Account\Documents\KARMA Motif\Yamaha Data\YourModel\ 
Windows XP: 
C:\Program Files\KARMA Motif\Yamaha Data\YourModel\ 

3. Transfer this file to a USB stick and load it into the XS or XF. Again, if you need help with this, you 
can find it in the owner’s manual. (Please load all data including the system! Do not try to 
selectively choose parts to load at this point as it will likely cause the software to operate 
incorrectly.)  
The Motif Data file contains: 

• 64 Motif Songs corresponding to 64 KARMA Performances 
• Custom Voices created by Karma-Lab (in the User 3 Voice Bank) used by the Songs (required) 
• Custom Drum Voices (in User Drum Bank) with KARMA mappings used by the Songs (required) 
• Required system level settings, such as MIDI sync, DAW type (for Remote Mode), etc. 
XF Users: Please note that since the data includes system settings, it will reset your screen settings to the 
red factory default format if you have changed it. You can easily modify this back to the way you had it, 
and save these settings with the KARMA Data if desired. 

   XS       XF 
The diagrams above show the File Mode load screen for the XS and XF. With the correct KARMA 
Yamaha Data File selected, press [SF2] [Load] to load the file. The “Type” menu should be set to 
“all”. For the XF, it doesn’t matter what the FL1 and FL2 settings are; there are no waveforms or 
samples in the KARMA Yamaha Data. 

http://karma-lab.com/karmasoft/kmo/docs.html#beginner
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4. Make sure that your Motif is on, and connected to the Mac or PC via the USB port (or FireWire port) 
before returning to the main instructions and finishing the setup procedure. 

If you are using FireWire and the FW16e or mLAN16E2 boards 

The Motif Data File contains system data that will properly configure the System settings of your Motif 
to work with the KARMA software. However, the “Interface: MIDI In/Out” setting will be set to “USB”. 
If you are using the FireWire FW16E expansion board for MIDI connectivity (or the older mLAN16E2 
board on the Motif XS), you need to manually change the MIDI In/Out setting to “FW” (or mLAN) as 
shown below. Press [UTILITY] and select the Control > MIDI page, as shown in the following diagrams: 

 

Furthermore, if you are using a Motif XS and the 
Yamaha Steinberg FW Driver, you will need to 
change the IEEE1394 Driver setting from the 
General > AutoLoad Page from mLAN to FW: 
 
Then press the [STORE] button to write this setting 
into your Motif. You may wish to save a new “all” file 
at this time containing this setting and all the rest of 
the KARMA Motif Factory Data for easy loading in 
the future. 
 
 
 
 
 
Please return to Page 2 for “Completion of the authorization.”  
  

XF XS 

XS only 
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MOX/MOXF – loading the KARMA Yamaha Data 

  
 Loading the MOX/MOXF Data - Overview 

Before you use the software, you must load the KARMA data that we provide into your MOX/MOXF, or 
the KARMA Performances will not play correctly. This will replace the data in your keyboard with our 
data. Therefore, it is strongly recommended that you backup the state of your machine to an “all” file 
on your USB stick prior to loading the KARMA data, so that you can restore your original setup later. 
This is the easiest way to try out the KARMA Motif software without having to wade through pages 
and pages of settings, and trying to load only certain banks of sounds. Later you can think about 
merging the KARMA data into your own file if that is something you wish to do. We provide 
instructions on this for advanced users in another document. However, for your first experience with 
KARMA Motif, the best and recommended method is to load our data file. 
If you have never done this before or are worried about this procedure, please read the rest of this 
section. Otherwise, proceed to the next section “Loading the MOX/MOXF Data - Procedure.” 
If you are new to the idea of replacing the contents of your keyboard with something else in order to 
use a specific program, think of it this way: the KARMA data is a "file for a particular purpose". The 
contents of the keyboard can be changed. You can load one file for one purpose, and another file for 
another purpose. This is common for more advanced users - it takes just a few moments to load a 
completely new file that changes all of the contents of your keyboard from one setup to another 
setup. You can have one set of data you use with KARMA, one set of data you use with a DAW, one set 
of data you use for live performance, etc. 
Why is this necessary? The KARMA software uses the 64 Songs in Song Mode to produce the music. 
The Songs themselves have various Voices loaded into each track to produce the correct sounds. If we 
were to only load the Songs, then if you had different Voices in your User3 Bank (for example), they 
would not sound correct because the Voices that we created the Songs to use might not be in the 
correct locations. That is why we need to get the keyboard set to a state where everything matches 
the data that we have produced. 
Secondly, various system settings need to be set a certain way for the whole thing to work correctly 
such as MIDI settings, Remote Mode settings, etc. We have configured the software to work with 
certain settings in the keyboard. If a user has changed those to something else, then it won't work 
correctly. That's why we replace everything with the correct settings for KARMA. All you have to do to 
reset your keyboard for other purposes is to load your own data file. 
Unfortunately, Yamaha does not provide a way to easily load just certain types of data, and certain 
system settings, without replacing the whole thing. We chose the easiest way to get the MOX/MOXF 
configured to match KARMA, by loading an "all" file with system settings. 
If you later wish to create your own version of the KARMA Yamaha Data that we supply, so that it also 
includes your own customized Voices, Performances, Masters etc. that you normally have loaded, you 
can follow the steps in a different tutorial named “Creating your own KARMA Yamaha Data File.” 
However, we don’t recommend doing that now until you’ve first experienced using the software with 
the correct data and settings. 
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Loading the MOX/MOXF Data - Procedure 

1. First, we highly recommend backing up the current state of your MOX/MOXF to an “all” data file 
on your USB stick. Then you can reload your own "all" file at any time, thereby returning your 
keyboard to the exact state it was in prior to loading our file. If you need help with this, please 
consult your owner’s manual, in the “Quick Guide > Saving/Loading  (File Mode)” section, or 
consult the “Yamaha Beginner’s Resources” section at karma-lab.com/kmo/docs. 

2. Locate the “Yamaha Data” folder in the application’s folder on your computer. On Windows, you 
will also find a shortcut to this folder in the Start Menu (and on the desktop). You will see a 
number of folders inside that contain data files for the different Yamaha Models that KARMA Motif 
supports. Open the folder for your MOX or MOXF – you will see one of the following “all” files: 

MOX: KMOFACT1.X4A  MOXF: KMOFACT1.X6A   

The default folders containing these files on your computer are: 

Mac: 
~/Applications/KARMA Motif/Yamaha Data/YourModel/ 

Windows 8, 7, Vista: 
C:\Users\Your Account\Documents\KARMA Motif\Yamaha Data\YourModel \ 

Windows XP: 
C:\Program Files\KARMA Motif\Yamaha Data\YourModel \ 

3. Transfer this file to a USB stick and load it into the MOX or MOXF. Again, if you need help with this, 
you can find it in the owner’s manual. (Please load all data including the system! Do not try to 
selectively choose parts to load at this point as it will likely cause the software to operate 
incorrectly.)  

The MOX and MOXF Data files contain: 

• 64 Motif Songs corresponding to 64 KARMA Performances 
• Custom Voices created by Karma-Lab (in the User 3 Voice Bank) used by the Songs (required) 
• Custom Drum Voices (in User Drum Bank) with KARMA mappings used by the Songs (required) 
• Required system level settings, such as MIDI sync, DAW type (for Remote Mode), etc. 
• A custom Control Template for the Remote Mode 

MOX       MOXF 

The diagrams above show the File Mode load screen for the MOX and MOXF. With the correct 
KARMA Yamaha Data File selected, press [SF1] [EXEC] to load the file. The “with System” checkbox 
should be checked. For the MOXF, it doesn’t matter if the other boxes are checked or not; there are 
no waveforms or samples in the KARMA Yamaha Data. 

4. Important! After the data file is finished loading, you must turn off the keyboard, and turn it back 
on. For some reason, this is necessary to make the custom Control Template we provide appear in 
Remote Mode #45. Yamaha has acknowledged that this step is necessary. 

5. Make sure that your keyboard is on, and connected to the Mac or PC via the USB port before 
returning to the main instructions and finishing the setup procedure. 

Please return to Page 2 for “Completion of the authorization.” 

Troubleshooting 
Error: Illegal file 
If the MOXF presents this error dialog while trying to load our KMOFACT1.X6A file, it means that your 
firmware is too old and needs to be updated to 1.03 or later. To view the firmware version of your 
MOXF, press the UTILITY button, then press the JOB button.  Visit download.yamaha.com for the latest 
firmware updater. 

http://karma-lab.com/karmasoft/kmo/docs.html#beginner
http://download.yamaha.com
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S70/S90 XS – loading the KARMA Yamaha Data 

 

 Loading the S70/S90 XS Data - Overview 

Before you use the software, you must load the KARMA data that we provide into your S70/S90 XS, or 
the KARMA Performances will not play correctly. This will replace the data in your keyboard with our 
data. Therefore, it is strongly recommended that you backup the state of your machine to an “all” file 
on your USB stick (or internal memory) prior to loading the KARMA data, so that you can restore your 
original setup later. 
This is the easiest way to try out the KARMA Motif software without having to wade through pages 
and pages of settings, and trying to load only certain banks of sounds. Later you can think about 
merging the KARMA data into your own file if that is something you wish to do. We provide 
instructions on this for advanced users in another document. However, for your first experience with 
KARMA Motif, the best and recommended method is to load our data file. 
If you have never done this before or are worried about this procedure, please read the rest of this 
section. Otherwise, proceed to the next section “Loading the Motif XS/XF Data - Procedure.” 
If you are new to the idea of replacing the contents of your S70/S90 XS with something else in order to 
use a specific program, think of it this way: the KARMA data is a "file for a particular purpose". The 
contents of the keyboard can be changed. You can load one file for one purpose, and another file for 
another purpose. This is common for more advanced users - it takes just a few moments to load a 
completely new file that changes all of the contents of your keyboard from one setup to another 
setup. You can have one set of data you use with KARMA, one set of data you use with a DAW, one set 
of data you use for live performance, etc. 
Why is this necessary? The KARMA software uses 64 Multis in Multi Mode to produce the music. The 
Multis themselves have various Voices loaded into each part to produce the correct sounds. If we were 
to only load the Multis, then if you had different Voices in your User3 Bank (for example), they would 
not sound correct because the Voices that we created the Multis to use might not be in the correct 
locations. That is why we need to get the S70/S90 XS set to a state where everything matches the data 
that we have produced. 
Secondly, various system settings need to be set a certain way for the whole thing to work correctly 
such as MIDI settings, Remote Mode settings, etc. We have configured the software to work with 
certain settings in the S70/X90 XS. If a user has changed those to something else, then it won't work 
correctly. That's why we replace everything with the correct settings for KARMA. All you have to do to 
reset your keyboard for other purposes is to load your own data file. 
Unfortunately, Yamaha does not provide a way to easily load just certain types of data, and certain 
system settings, without replacing the whole thing. We chose the easiest way to get the S70/S90 XS 
configured to match KARMA, by loading an "all" file with system settings. 
If you later wish to create your own version of the KARMA Yamaha Data that we supply, so that it also 
includes your own customized Voices, Performances, Masters etc. that you normally have loaded, you 
can follow the steps in a different tutorial named “Creating your own KARMA Yamaha Data File.” 
However, we don’t recommend doing that now until you’ve first experienced using the software with 
the correct data and settings. 
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Loading the S70/S90 XS Data - Procedure 

1. First, we highly recommend backing up the current state of your S70/S90 XS to an “all” data file on 
your USB stick or internal memory. Then you can reload your own "all" file at any time, thereby 
returning your unit to the exact state it was in prior to loading our file. If you need help with this, 
please consult your owner’s manual - in the “Saving/Loading Data (File Mode)” section, or consult 
the “Yamaha Beginner’s Resources” section at karma-lab.com/kmo/docs. 

2. Locate the “Yamaha Data” folder in the application’s folder on your computer. On Windows, you 
will also find a shortcut to this folder in the Start Menu (and on the desktop). You will see a 
number of folders inside that contain data files for the different Yamaha Models that KARMA Motif 
supports. Open the folder for the S70/S90 XS – you will see the following “all” file: 

KMO Factory 1.X2A 
The default folders containing these files on your computer are: 

Mac: 
~/Applications/KARMA Motif/Yamaha Data/S70-S90 XS/ 
Windows 8, 7, Vista: 
C:\Users\Your Account\Documents\KARMA Motif\Yamaha Data\S70-S90 XS\ 
Windows XP: 
C:\Program Files\KARMA Motif\Yamaha Data\S70-S90 XS\ 

3. Transfer this file to a USB stick and load it into the S70/S90 XS. Again, if you need help with this, 
you can find it in the owner’s manual. (Please load all data including the system! Do not try to 
selectively choose parts to load at this point as it will likely cause the software to operate 
incorrectly.)  
The S70/S90 XS Data file contains: 

• 64 Multis corresponding to 64 KARMA Performances 
• Custom Voices created by Karma-Lab (in the User 3 Voice Bank) used by the Multis (required) * 
• Custom Drum Voices (in User Drum Bank) with KARMA mappings used by the Multis (required) 
• Required system level settings, such as MIDI sync, DAW type (for Remote Mode), etc. 
• Custom Control Templates for the DAW Remote Mode 

* Note: The original content of Voice Bank User 3 has been moved to User 4 (which is normally empty in an 
S70/S90 XS Factory Reset). 

 
The diagrams above show the File Mode load screens for the S70/S90 XS, with a USB stick inserted. 
The [ENTER] button is pressed between each step. With the “KMO Factory 1.X2A” KARMA Yamaha 
Data File selected, press [ENTER] and select the “All” setting, then press [ENTER] to load the file.  

4. Make sure that your S70/S90 XS is on, and connected to the Mac or PC via the USB port before 
returning to the main instructions and finishing the setup procedure. 

 
Please return to Page 2 for “Completion of the authorization.”  
  

http://karma-lab.com/karmasoft/kmo/docs.html#beginner
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Motif Rack-XS – loading the KARMA Yamaha Data 
 

 
Loading the Motif Rack-XS Data - Overview 

In order for the Motif Rack-XS to be used with KARMA Motif Software, you need to load the Rack-XS 
data that we provide. It contains the modified Voices, modified Drum Kits, and the 64 Factory 
Performances (Multis) that correspond to the 64 Performances in the KARMA Motif Software. If you do 
not load the Rack-XS data, nothing will work correctly. 
Unfortunately, this is not the easiest task, since Yamaha did not provide a way to use a USB stick to 
save and transfer files. The only way this can be accomplished is with MIDI SysEx Messages sent back 
and forth between the computer and the Rack over the USB or FireWire cable. 
This document explains several methods by which to load the required data into your Rack-XS: 

Method 1: Using the “Motif Rack-XS Total Librarian” program by John Melas 
Method 2: Using your favorite DAW/Sequencing program, and a Standard MIDI File 
Method 3: Using the Yamaha Motif Rack-XS Editor 

It is highly recommended that you backup the data in your Rack-XS before loading the KARMA Motif 
Data. For example, you may have modified some of the Voices in the User 3 Voice Bank, or the User 
Drums Bank, or you may have modified some of the Multis. Please consult the instructions below for 
different methods of backing up the data. 
You should perform these operations without having KARMA Motif running, as KARMA Motif also 
sends SysEx messages back and forth to the Rack-XS, and we don’t want anything to interfere with the 
loading of the data into the Rack via SysEx.  

What does the data contain? 

The following is what will be loaded into the Rack-XS and/or changed: 
- Voice Bank USR 3 (User Bank 3) 
- Drum Bank UDR (User Drums) 
- Multis 1 ~ 64 
- Voice Bank USR 1 & 2 (User Banks 1 & 2) will also be replaced when using Method 3 

The System Settings (Utility Mode) must be set up manually, as there is no way to dump them to the 
Rack-XS via SysEx. 

Method 1: Total Librarian 

This method uses the “Motif Rack-XS Total Librarian” program by John Melas. This is the simplest and 
easiest method by far to backup and load new data into a Rack-XS; however, it requires owning the 
program. We highly recommend purchasing this program to use with KARMA Motif, as it’s very useful 
for managing your Rack-XS’s data in general – and John has been extremely helpful in adding features 
and improvements that have allowed us to actually support the Rack-XS in the first place. 
Furthermore, compared to the other method of getting the data into the Rack-XS (and especially 
performing a backup of the current data), owning this program is a no-brainer. And the TL is only one 
of his tools for the Rack-XS; all of them are excellent and useful. The Motif Rack-XS Total Librarian is 
available for 35 Euros (about $45 US) from jmelas.gr/motif/lib.php. 
There are four steps to work through: 

1. Setting up the Total Librarian 
2. Backing up your current data 
3. Sending the KARMA Motif Data 
4. Making the System Settings  

http://jmelas.gr/motif/lib.php
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1. Setting up the Total Librarian (TL)  
It is assumed you have already installed the program and 
registered it according to the procedures supplied by John 
Melas. Assuming your Rack-XS is connected to the 
computer via USB or FireWire, you should be able to launch 
the TL and connect it to the Rack-XS using the TL’s Setup 
Menu > AutoConnect command.  
 
Please make sure you are using Total Librarian version 2.4 
or higher – it contains some necessary improvements to the 
sending of Multis with Mix Voices. 
 
If you have problems with the data transmission, you may 
need to adjust the “Bulk Dump Interval” (see 
Troubleshooting below) – but for now, leave it at the 
default of 25 msec. 
 
 
 
2. Backing up your current data 
It is highly recommended that you backup the data in your Rack-XS before loading the KARMA Motif 
Data – because we are about to replace parts of it. For example, you may have modified some of the 
Voices in the User 3 Voice Bank, or the User Drum Bank, or you may have modified some of the Multis. 
Backing up your data allows you to restore the Rack-XS to its 
previous state when you are not using it with KARMA. Fortunately, 
this is extremely easy with the TL. 
 When you launch the TL, it will open a default new TL document 
(empty) named “Total Library 1.” From the Edit Menu, choose 
“Receive All…” and you will see the dialog to the right. 
We advise selecting all five items in the list, so that you have a 
complete backup of the state of the unit in terms of the writable 
user memory for Voices and Multis. 
Then click “OK” – the Rack-XS will begin sending data to the TL. 
Receiving all 3 User Voice Banks, the User Drum Bank and 128 
Multis takes approximately 3 minutes. 
 
 
When the procedure is finished, 
you can view your Voices, 
Drum Voices and Multis in the 
TL by clicking on the various 
folder icons. Remember to save 
the file (as shown to the right)! 
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3. Sending the KARMA Motif Data 
1. In the Rack-XS’s Utility settings, MIDI 

2/6, make sure that the first 3 settings 
are all set to “on” (Bank Select Sw, Prg 
Change Sw, Receive Bulk). 
 

2. From the TL File Menu, choose the “Open…” command and locate the KMO Factory Data 1.allrxs 
file. This file is included on your computer’s hard drive by the installation process, inside the 
“Yamaha Data” folder in the application’s KARMA Motif folder. On Windows, you will also find a 
shortcut to this folder in the Start Menu (and on the desktop). 
The file is located inside the “KARMA Motif > Yamaha Data > Rack-XS > Total Librarian” folder. The 
default full path names to the folder are: 

Mac: 
~/Applications/KARMA Motif/Yamaha Data/Rack-XS/Total Librarian/ 
Windows 8, 7, Vista: 
C:\Users\Your Account\Documents\KARMA Motif\Yamaha Data\Rack-XS\Total Librarian\ 
Windows XP: 
C:\Program Files\KARMA Motif\Yamaha Data\Rack-XS\Total Librarian\ 
 

3. This file contains only Voice Bank 
User 3, the User Drum Bank, and 
Multis 1~64, so choose “Transmit 
All…” from the TL’s Edit Menu, and 
set the dialog as shown to the right, 
then click OK.  
 
It takes approximately 14 minutes 
to send all of the data (with the 
default “Bulk dump interval” setting 
of 25 ms). 

 
Note that this only replaces Multis 
1~64 - the Multis you have in 
65~128 remain as they are. 
 
 
 

4. Making the System Settings 
See the section Motif Rack-XS – making the System Settings, since this step is the same for all three 
methods. 
 
 
Troubleshooting 
Error: MIDI buffer full 
Error: Illegal bulk data 
If the Rack-XS presents any error dialogs during or at the end of the procedure such as “MIDI buffer 
full” or “Illegal bulk data”, you may need to increase the “Bulk Dump Interval” in Total Librarian to slow 
down the transmission of the data - try a larger value such as 50 ms. Note that this will make the 
transmission take longer. 
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Error: Mixing Voices full 
You might see this error on the Rack-XS if you have Multis in locations 65~128 that contain Mixing 
Voices. The reason this could happen is that the 64 KARMA Multis 1~64 use up 248 Mixing Voices, out 
of a possible maximum of 256 Mixing Voices. 
If you have customized Multis in the rack that are using Mixing Voices, and they are using more than 8 
Mixing Voices, you will likely get a “Mixing Voice full” error at some point during the sending of the 64 
Multis in the Factory Data. In fact, the Yamaha devices seem a bit picky about the order of operations 
when so many of the Mix Voices are being used. 
In this case, we recommend you do a Factory Reset before sending the data. That clears out all of the 
Mixing Voices (since the 128 Factory Multis do not use any Mixing Voices).  See the section Motif Rack-
XS - performing a Factory Reset (optional). 
 

Method 2: Using a Sequencing Program or DAW 

This method uses your DAW or sequencing program to send the KARMA data to your Rack-XS from a 
.MID file. You can do this with any sequencing program that supports the import of Standard MIDI 
Files in .MID format. The main disadvantage to this method compared to the previous one is that there 
is no easy way to backup the current state of your Rack-XS. Yamaha did not provide a way to dump an 
entire bank of Voices or the entire bank of Multis. Instead, you have bulk dump each Voice or Multi 
you want to save one-by-one. That’s one of the main advantages of the Total Librarian program 
explained in the previous method – it automates the process of getting all the bulk dumps you need 
in order to backup multiple banks at the same time. 
There are four steps to work through: 

1. Backing up your current data 
2. Importing the KARMA Data .MID file into your program 
3. Sending the KARMA Data 
4. Making the System Settings 

Please also see the sections in your Rack-XS Owner’s Manual related to “Saving data to an external 
device.” 
 
1. Backing up your current data 
If you have any modified voices in the User 3 Voice Bank, or modified drum voices in the User Drum 
Bank, or modified Multis in the Multi Bank, they will be overwritten. You should consider backing them 
up. 
One last time: we recommend getting the Rack-XS Total Librarian program as explained in Method 1. But 
OK, if you insist: 
In general, the procedure goes like this. To back up a voice: 

1. Set a track in your sequencing program to receive on Port 1 from the Rack-XS (USB Driver) or 
the Main Port (FW Driver). Arm the track for record. 

2. Select the voice in the Rack-XS that you want to backup. 
3. Start recording in the sequencer. 
4. On the Rack-XS, hold down the [VOICE] button and press the [STORE] button – the bulk dump 

begins and should be recorded onto the sequencer track as SysEx data. The Rack display will 
show “Now transmitting MIDI bulk data…” 

5. When the “transmitting” dialog on the Rack-XS goes away, stop recording. You have captured 
an Edit Buffer dump of the currently selected voice. 

To restore this voice to the Rack-XS at a later time: 
1. Select the Voice Mode and the location in a User Voice Bank you would like to put the dump 

in. 
2. Set the sequencer track’s MIDI output to Port 1 of the Rack-XS (or the Main Port if using FW). 
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3. Play the track from the beginning. You should see the Rack receive the data with the message 
“Now receiving MIDI bulk data…” 

4. When it finishes, you will see the voice name in the Rack display. However, note that this is 
only in the Edit Buffer and if you select another voice now, it will be lost. Before you leave this 
voice, you need to press the [STORE] button and complete the procedure of storing the voice 
in that location. 

The procedure for backing up a Multi is exactly the same, except you choose the Multi Mode and the 
Multi you wish to backup, and hold down the [MULTI] button while pressing the [STORE] button. 
 
Here is an example of backing up a Voice using 
Cubase AI6 in Mac OS X: 
1. Launch Cubase AI6 and create an empty project. 
 
 
 
 
 
 
 
 
 
2. Open the Cubase Preferences, and make sure that 

SysEx is not checked in the MIDI-MIDI Filter 
section, or you will not record anything. 

 
 
 
 
 
 
 
 
 
 

 
3. From the Project menu, select Add Track > MIDI. 

When the “Add MIDI Track” dialog comes up, just 
click “Add Track.” A single MIDI track appears in 
the main window. 

4. Set the MIDI Input of the Track to Port 1 of the 
Rack-XS (USB) or the Main Port (FW), and make 
sure it is armed for recording.  

5. Choose the voice in the Rack-XS that you wish to 
dump. 

6. Locate back to the beginning of the track and start 
recording in Cubase.  
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7. Hold down the [VOICE] button on the Rack 
and press the [STORE] button. Transmission 
of the dump begins. When it finishes, stop 
recording. 

8. You should see some data recorded into 
the track. If you open a Key Editor Window 
and set the Controller Lane to display 
“System Exclusive”, you should see multiple 
recorded SysEx messages similar to the 
example shown to the right. 

 
 
2. Importing the KARMA Data .MID file into your program 
The procedure for this differs depending on which program you are using, but should be similar for 
most of them. If you run into difficulties, check your program’s documentation related to “Importing 
Standard MIDI Files.” The basic procedure is: 
1. Create an empty project and import the .MID file, or open the .MID file, which creates a new 

project. 
2. Set the resulting track(s) of data to transmit on Port 1 of the Rack-XS (USB) or the Main Port (FW). 
3. Play the track at the default tempo of 120 BPM, until all of the data has been received by the Rack-

XS. The full track of data takes approximately 14 minutes at 120 BPM. 
 
This example uses Cubase AI6 in Mac OS X. 
1. Launch Cubase AI6 and create an empty project. 
2. From the File Menu, choose “Import > MIDI File…” 
3. When the dialog appears “Do you want to create a 

new project?,” answer “No.” 
4. When the “Choose File” dialog opens, locate and 

select the “KMO Factory Data 1.mid” file.  
This file is included on your computer’s hard drive 
by the installation process, inside the “Yamaha 
Data” folder in the application’s KARMA Motif 
folder. On Windows, you will also find a shortcut 
to this folder in the Start Menu (and on the 
desktop). 

 
The file is located inside the “KARMA Motif > Yamaha Data > Rack-XS > Standard MIDI” folder on 
your computer. The default full path names to the folder are: 

Mac: 
~/Applications/KARMA Motif/Yamaha Data/Rack-XS/Standard MIDI/ 
Windows 8, 7, Vista: 
C:\Users\Your Account\Documents\KARMA Motif\Yamaha Data\Rack-XS\Standard MIDI\ 
Windows XP: 
C:\Program Files\KARMA Motif\Yamaha Data\Rack-XS\Standard MIDI\ 

5. While most programs will end up with a single track of data, Cubase ends up creating 3 tracks for 
some reason (shown below): an empty VST Instruments Track (which you can ignore), an “Acoustic 
Piano” track containing the Program Changes used by the dumping of the Multis, and a “SysEx 
Data” track containing the rest of the SysEx data. 
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6. You must set the MIDI Output of both the Piano and SysEx tracks to Port 1 of the Rack-XS (USB) or 

the Main Port (FW) as shown above. 
 
3. Sending the KARMA Data 
1. In the Rack-XS’s Utility settings, 

MIDI 2/6, make sure that the first 
3 settings are all set to “on” (Bank 
Select Sw, Prg Change Sw, 
Receive Bulk). 

2. Reset the sequencer to the beginning of the tracks, and then play the sequence at the default 120 
BPM tempo. You will see the Rack-XS begin to receive MIDI data with the “Receiving MIDI bulk 
data…” message. This will continue for quite some time. It takes approximately 14 minutes to 
send all of the data at 120 BPM. You can watch the sequencer to see when you are nearing or 
reaching the end of the data on the SysEx Track. 

 
4. Making the System Settings 
See the section Motif Rack-XS – making the System Settings, since this step is the same for all three 
methods. 
 
Troubleshooting 
Error: MIDI buffer full 
Error: Illegal bulk data 
If the Rack-XS presents any error dialogs during or at the end of the procedure such as “MIDI buffer 
full” or “Illegal bulk data”, you may need to slow down the tempo of the sequence. By default, this data 
file should play at 120 BPM, but if you are getting errors, you can try setting the tempo to a lower 
value, such as 100 BPM. Note that this will make the transmission take longer. 
Error: Mixing Voices full 
You might see this error on the Rack-XS if you have Multis in locations 65~128 that contain Mixing 
Voices. The reason this could happen is that the 64 KARMA Multis 1~64 use up 248 Mixing Voices, out 
of a possible maximum of 256 Mixing Voices. 
If you have customized Multis in the rack that are using Mixing Voices, and they are using more than 8 
Mixing Voices, you will likely get a “Mixing Voice full” error at some point during the sending of the 64 
Multis in the Factory Data. In fact, the Yamaha devices seem a bit picky about the order of operations 
when so many of the Mix Voices are being used. 
In this case, we recommend you do a Factory Reset before sending the data. That clears out all of the 
Mixing Voices (since the 128 Factory Multis do not use any Mixing Voices).  See the section Motif Rack-
XS - performing a Factory Reset (optional). 
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Method 3: Using the Yamaha Motif Rack-XS Editor 

This method uses the free Yamaha Motif Rack-XS Editor (available from download.yamaha.com). If you 
are going to use this method, it is assumed that you already have the latest version installed and know 
how to use it. 

The advantage to this method over the previous one is that you can backup and restore entire banks 
of Voices at one time. The disadvantage is that there is no way to backup and restore an entire bank of 
Multis – you have to backup each Multi as an individual .X1E Editor file, one at a time. And to load our 
64 Multis into the rack, you have to open each of the 64 Multi files one by one and transmit it to the 
proper location in the Multi Bank. This can take quite a bit of time, and is prone to user errors such as 
storing the wrong Multi in the wrong location. However, another potential advantage is that you can 
load only the single Multi you wish to work with at any given time – although you still need to load the 
complete User 3 Voice Bank, User Drum Bank and System Settings to ensure any given Multi works 
correctly. 

Again, we highly recommend getting the Total Librarian program as explained earlier in Method 1. 
However, assuming you wish to proceed with using the Rack-XS Editor, there are five steps to work 
through: 

1. Backing up your current data (Voice Banks, Global, Current Multi) 
2. Backing up the rest of the Multis 
3. Sending the Voice Banks, Global Settings and first Multi 
4. Sending the rest of the Multis 
5. Making the rest of the System Settings 

 
Note: Since the 64 Multis are provided as 64 individual .X1E Editor files, and each is about 1.2 MB of data (77 
MB total uncompressed), the files have been included as a compressed .zip archive. If you want to use this 
method, you need to unzip the archive. 
 

The archive is named “Rack-XS Editor.zip” and is located inside the “KARMA Motif > Yamaha Data > 
Rack-XS” folder. The default full path names to the folder are: 

Mac: 
~/Applications/KARMA Motif/Yamaha Data/Rack-XS/ 

Windows 8, 7, Vista: 
C:\Users\Your Account\Documents\KARMA Motif\Yamaha Data\Rack-XS\ 

Windows XP: 
C:\Program Files\KARMA Motif\Yamaha Data\Rack-XS\ 

 

Once you have unzipped this file, you will have a folder 
named “Rack-XS Editor” containing 64 separate .X1E files 
(example shown at right). 

 
 
Note: We have only tested this method using the standalone 
version of the Editor 1.6.6. The diagrams are from the Mac 
OS X version. 
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Before beginning, in the Rack-XS’s 
Utility settings, MIDI 2/6, make sure 
that the first 3 settings are all set to 
“on” (Bank Select Sw, Prg Change Sw, 
Receive Bulk). 
 
1. Backing up your current data (Voice Banks, Global, First Multi) 
If you have any modified voices in the three User Voice Banks, or modified drum voices in the User 
Drum Bank, or modified Multis in the Multi Bank, they will be overwritten when loading the KARMA 
Yamaha Data. You should consider backing them up, so that you can restore them later when not 
using KARMA. 
1. Select the Multi Mode on the Rack-XS, and select the first Multi that 

you would like to back up. 
2. With the Editor set to Multi Mode, click the “Offline” button to bring 

it “Online.”  
 

3. In the resulting “Auto Sync” 
dialog, under “Auto Sync 
Setting”, turn on all three rows 
and specify the direction from 
the Rack-XS to the PC (as 
shown). 

4. Press the Start button to begin. 
It will take a few minutes. 

 
 
 
5. When finished, you can save the file using the File Menu’s “Save As…” 

command. You could give it the name of the Current Multi, for 
example. This will be a backup of all three User Voice Banks, the User 
Drum Bank, the Current Multi, and the Editor’s Global Settings.  
 

Note: The Global Settings in the Editor are just the Controller Assign settings 
and the Micro Tuning Settings, and not all of the System Settings in the Rack-
XS. 
 
2. Backing up the rest of the Multis 
Unfortunately, it’s not so easy to back up Multis using the Editor, since it does not have the ability to 
back up the entire bank of Multis at once. You can only do them one at a time, and save each Multi as 
an individual .X1E file. 
What we did in the previous step was to back up all three User Voice Banks, the User Drum Bank, the 
Current Multi, and the Editor’s Global Settings. That leaves the rest of however many Multis you want 
to back up. Fortunately, backing up single Multis is faster. 
1. Continuing from the previous step, the Rack-XS is in Multi Mode, and the Editor is Online. 
2. On the Rack-XS, advance to the next Multi that you wish to back up. As you switch Multis, the Rack 

will transmit the new Multi data to the Editor, and you should see the “Please Wait” message over 
the Editor’s screen. 

3. Once the transmission is complete, just use the File Menu “Save As…” command again to save the 
Editor file with the name of the Current Multi.  
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4. Proceeding in this manner, you can back up all of the Multis that you need to, one at a time, to 
individual .X1E Editor files. 

Note that each file you save at this point contains the backed up User Voice Banks, User Drum Bank and 
Global Settings, and one Multi. You could use any of these files to restore the Voice Banks in the future. 

 
3. Sending the Voice Banks, Global Settings and first Multi 
Now that your backup is accomplished, we will send the three User Voice Banks, the User Drum Bank, 
some Global Settings, and the first Multi from the first KARMA Data File. 

 

 

1. Put the Rack-XS in Multi Mode and make sure that Multi 001 is selected. 
The Editor should still be in Multi Mode and Online. 

 

 

 

 

 

2. Use the File Menu “Open…” 
command to locate and open our 
first KARMA Rack-XS Editor file        
“01 Industrial Strength.X1E”.  

(Answer no if you are asked to save 
any changes.) 

 
 
 
 
 
 
 
 

 

3. At this point, the “Auto Sync” 
dialog should appear.  

4. Make sure that the three rows 
under “Auto Sync Setting” are 
still turned on, and change the 
direction to transmit from the PC 
to the Rack-XS (as shown).  

5. Press the Start button to begin. It 
will take a few minutes to 
complete the transmission. 

 

 

6. You should see now that Multi 001 in the unit is named 
“Industrial Strength.” However, note that this is only in the 
edit buffer. If you change Multis now, the Multi will go back to 
being “Chilltronika.” 
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7. Therefore, store the Multi in the current slot. You can do this 

in one of two ways:  
a. Press the [STORE] button on the Rack-XS, and store it to 

the current location. 
b. Choose “Store Mixing…” from the Edit Menu of the 

Editor. 
 
At this point, you could actually try out the first Multi with the first 
KARMA Performance, since all of the required Voices are loaded, 
but we recommend finishing the procedure. 

 
 
 

4. Sending the rest of the Multis 
All three User Voice Banks, the User Drum Bank and certain Global Settings have been stored in the 
Rack-XS, along with the first Multi. Now, there are only 63 more Multis to go… (which again, is why we 
recommend the Total Librarian program and Method 1). 
 
1. To continue with the next Multi, on 

the Rack-XS, advance the Multi to 
“002: East Sider.” Wait for the Editor 
and the Rack to finish 
communicating. 
 

2. Use the File Menu “Open…” 
command to open the next KARMA 
Rack-XS Editor File “02 The Acid 
Test.” Answer no when asked if you 
want to save any changes. 

 
 
 
 
3. This time, when the “Auto Sync” 

dialog appears, turn off the 
Global and Voice rows under 
“Auto Sync Settings,” leaving 
only Current turned on. This way, 
we will only send the Multi data, 
and not all of the Voice data 
(which we already sent 
previously). 

4. Click the Start button and the 
second Multi is quickly 
transmitted to the Rack. 

5. You should now see that Multi 002 is named “The Acid Test” in the Rack-XS. Again, store the Multi 
by pressing the [STORE] button on the Rack, or by using the Editor’s Edit Menu “Store Mixing” 
command. 
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You have now stored the second KARMA Multi in the second Multi location. It is a simple matter (but 
time-consuming) to continue this for each of the remaining 62 Multis: 
1. In the Rack-XS, advance to the next Multi. Wait for any transmission between the Rack and Editor 

to stop. 
2. Choose “Open…” from the Editor’s File Menu, answer no to the dialog that asks if you want to save 

changes. 
3. Select the next KARMA Rack-XS Editor File that corresponds to the Multi number.  
4. When the Auto Sync Dialog comes up, click Start to transmit the “Current” to the Rack-XS. 
5. Store the Multi in the current location, using the Rack or the Editor. 
It’s easy to forget to store the Multi before moving on to the next one. Chanting this mantra while 
working can help: “next…open…select…transmit…store.” 
 
5. Making the rest of the System Settings 
See the section Motif Rack-XS – making the System Settings, since this step is the same for all three 
methods. (The Global Settings that were transmitted from the Editor are only a small portion of the 
required settings.) 
 
Troubleshooting 
Error: Mixing Voices full 
You might see this error on the Rack-XS if you have Multis in locations 65~128 that contain Mixing 
Voices. The reason this could happen is that the 64 KARMA Multis 1~64 use up 248 Mixing Voices, out 
of a possible maximum of 256 Mixing Voices. 
If you have customized Multis in the rack that are using Mixing Voices, and they are using more than 8 
Mixing Voices, you will likely get a “Mixing Voice full” error at some point during the sending of the 64 
Multis in the Factory Data. In fact, the Yamaha devices seem a bit picky about the order of operations 
when so many of the Mix Voices are being used. 
In this case, we recommend you do a Factory Reset before sending the data. That clears out all of the 
Mixing Voices (since the 128 Factory Multis do not use any Mixing Voices).  See the section Motif Rack-
XS - performing a Factory Reset (optional). 
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Motif Rack-XS – making the System Settings 
 
Since the System settings of the Rack-XS cannot be dumped via SysEx, you must set the required 
System settings manually. Please make the following settings on your Rack-XS. (Likely, many of them 
are already set correctly, but please check.)  
The first five screens to the right are 
from the Multi Mode [UTILITY] page. 
In the sixth screen, the Receive 
Channel must be set in the Voice 
Mode UTILITY page, or the Rack-XS 
will not respond to Performance 
changes sent by KARMA in either 
Voice or Multi Mode. 
 
Multi Mode > [UTILITY]: 
1. [UTILITY] > [MIDI] > [MIDI 1/6] 

MIDI In/Out = USB or mLAN 
MIDI Sync = external  
ClockOut = off 
LocalCtrl = on 
Device No. = all 

2. [UTILITY] > [MIDI] > [MIDI 2/6] 
Bank Select Sw = on 
Prg Change Sw = on 
Receive Bulk = on 

3. [UTILITY] > [Controller] > [Controller 1/3] 
22   RB Ctrl No.   (Ribbon Controller) 
11   FC 1 Ctrl No.  (Foot Controller 1) 
04   FC 2 Ctrl No.  (Foot Controller 2) 
88   FS Ctrl No.   (Foot Switch) 

4. [UTILITY] > [Controller] > [Controller 2/3] 
16   AS 1 Ctrl No.  (Assign 1 Control) 
17   AS 2 Ctrl No.  (Assign 2 Control) 
86   A.Func1 Ctrl No.  (A. Function 1 Control) 
87   A.Func2 Ctrl No.  (A. Function 2 Control) 
02   BC Ctrl No.   (Breath Controller) 

5. [UTILITY] > [General] > [General 2/5] 
IEEE1394 Driver = FW (if using the FW/mLAN board and Steinberg Drivers) 

Voice Mode [UTILITY]: 
6. [UTILITY] > [Voice MIDI] 

Receive Ch = 1 
Transmit Ch = 1 

7. Press the [STORE] button to write the settings to the Rack XS’s memory. 
If using FireWire, see the next page for more information. 
 
Please return to Page 2 for “Completion of the authorization.”  
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Using FireWire and the mLAN16E2 board 

If you are using the mLAN16E2 board with your Rack-XS for FireWire connectivity, you need to have 
the MIDI In/Out setting set to mLAN as shown below. Furthermore, if you are using the Yamaha 
Steinberg FW Driver, you need to change the IEEE1394 Driver setting from mLAN to FW: 

 
1. [UTILITY] > [MIDI] > [MIDI 1/6] 
          MIDI IN/OUT = mLAN 
 
2. [UTILITY] > [General] > [General 2/5] 
          IEEE1394 Driver = FW 
 
3. Press the [STORE] button to write the settings to the Rack-XS’s memory. 

 
Please return to Page 2 for “Completion of the authorization.”  
 
 

Motif Rack-XS - performing a Factory Reset (optional) 
 
If you are receiving a “Mixing voice full” error when sending Multis to the Rack-XS, you may need to 
perform a Factory Reset of the Rack-XS. Why? Due to the fact that the 64 Multis we provide use up 248 
of the 256 possible Mixing Voices in the Multi Mode, if you have used more than 8 Mixing Voices in 
any custom Multis (including the ones in the 65~128 locations, which loading the KARMA Motif data 
does not replace), the data will not be properly loaded and you will get a “Mixing Voice full” error. 
Therefore, to avoid this, and to make a clean install of the KARMA Motif Data, we recommend 
performing this step.  

 
1. On the Rack-XS, in Multi-Mode, press the [Utility] button and select [Fctry Set]. Press [ENTER]. 
2. The Utility Factory Set screen appears. Press [ENTER] again. 
3. The Confirmation appears. Press [ENTER] a third time. The Factory Reset will begin and a progress 

screen will be shown. It takes a minute or so to finish the reset. 
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